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Michelle is a full-time multi-disciplinary 
creative, whose work spans from 
printmaking to 3D animation.

ABOUT PURCINELLA PRESSABOUT PURCINELLA PRESS

Purcinella Press is based in Mosta, Malta 
and is run by Michelle Gruppetta.

Purcinella Press designs and produces 
vibrant risograph prints for a range of 
clients, from NGOs, artists, brands and 
other organizations.

Purcinella Press offers custom services 
with a strong focus on design.



Risograph (or just riso) printing 
is a fun, eco-friendly print process 
that combines layering vibrant 
spot colour ink with photocopier 
speed, to create beautiful, analogue 
imperfection.

Risograph printing isn’t about 
perfection- the prints have a unique 
character that stand apart from 
digital printing. The idiosyncratic 
process transforms the work into 
something truly special, which is 
what sets this printing method 
apart.

WHAT IS RISOGRAPH PRINTING?WHAT IS RISOGRAPH PRINTING?

FUN FACT:  

Risograph p
rinting  

was develop
ed in Japan

  

in the 198
0s!



HOW DOES IT WORK?HOW DOES IT WORK?
RISO turns your greyscale artwork 
into bright, colourful risograph prints.

The darker the artwork, the more ink 
is printed. Black prints solid, white 
stays white, and lighter areas appear 
as pale tones.

Each ink colour is printed separately.
A three-colour print in blue, red and 
yellow requires 3 greyscale PDFs 
- one file with all the blue artwork, 
one with all the red, and one with all 
the yellow artwork. You can use any 
number of inks/colours we have in 
stock to create your artwork.

BLUE.pdf RED.pdf YELLOW.pdf
FINAL 

RISO PRINT
+ + =

100% Black = 100% Printed Colour. 
50% Black = 50% Printed Colour.



HOW DOES IT WORK? - CONT.HOW DOES IT WORK? - CONT.
Artwork is sent to the risoprinter 
either by scanning it directly or via a 
computer connection. 

The artwork is then burned into a 
sheet of thermal-sensitive paper by 
the printer, also known as a master.

This stencil is then wrapped around 
the ink drum, and ink is pushed out of 
the drum, through the stencil 
and onto the paper. 

Each colour is printed using a separate 
drum, with inks overlapping to build 
up the artwork.

That means that if you have an artwork 
that uses more than one colour, the 
same sheet of paper gets fed through 
the machine again and again.

  s
tencil/screen

stenc
ink drum

INPUT TRAY

PAPER
FEED ROLLER NEEDLE

PRINTS

OUTPUT TRAY
INK 

TUBE

Diagram by 
Risotto Studio.



WHAT CAN YOU PRINTWHAT CAN YOU PRINT
WITH RISO?WITH RISO?
The riso printer prints a max 
size of A3 - so regardless of 
your project, everything is 
laid out on an A3 template.

However, it can print A2 or 
even A1 if that final result is 
folded, such as a newspaper.

It only prints on paper!

You can also print full colour 
artworks and photos using a 
faux CMYK method!

MAX PRINTABLE AREA ON 
AN A3 IS 287mm x 410mm.

YOU CAN PRINT:

ART PRINTS

POSTERS

FLYERS

BUSINESS CARDS

MENUS + PLACEMATS

ZINES

PROGRAMS + MAPS

CARDS

PHOTOS

PAPER BAGS + ENVELOPES

SMALL PUBLICATIONS

NEWSPAPERS



RISOGRAPH PRINTING IS:
Efficient and affordable!
Has the speed, low-cost and efficiency 
of a modern photocopier.

Eco-friendly!
Riso printing uses a cold printing 
technology, is highly energy efficient 
and sustainable printing method, 
unmatched by other printing 
techniques. It also uses soy-based 
inks, and uses no water or alcohol in 
its process.

Unique!
Combines the best of digital and 
traditional printing with vibrant 
colours and beautiful texture to 
achieve a gorgeous hand-made feel!

WHY SHOULD YOU CHOOSE RISO?WHY SHOULD YOU CHOOSE RISO?

MAN, I’M THE BEST



IT’S  ECO-FRIENDLY: IT’S  AFFORDABLE:
At Purcinella Press, we do our best to minimize our 
impact on the environment. We source sustainable 
FSC certified paper, and reuse as much as we 
possibly can, using the paper for test prints and 
misprints over and over. We recycle everything 
else. 

The risograph printer is especially designed for 
fast, high-volume output. It is very efficient, so 
once the artwork is set up, the more you print the 
cheaper each print gets. 

Riso printing itself is a more sustainable printing 
method. It is a cold printing method and highly 
energy efficient, making ethical, mindful products, 
which can’t be matched by other printing methods. 
It uses minimal energy and no water at all.

Printing services are also only charged at 5% VAT.

The riso inks themselves are soy based, and the 
stencil is ready to be used right from the start, 
minimizing ink waste. 

Our pricing and quotes are calculated by the 
number of stencils used, the types of inks (as some 
are more expensive than others) and the quantity 
and type of paper.

The most economical jobs are the ones that use 
few colours and stencils, but have a higher print 
quantity. The more expensive jobs involve more 
colours and stencils at a low print quantity.

Since the requirements of all print jobs vary, we 
have no set price list and quote based on the job.

WHY SHOULD YOU CHOOSE RISO? WHY SHOULD YOU CHOOSE RISO? 
- CONT- CONT



INKS/COLOURSINKS/COLOURS

BLACK 
#000000 

Black U

TEAL 
#00838A 

321 U

YELLOW 
#FFE800 
Black U

BLUE 
#0078BF 

3005 U

ORANGE 
#FF6C2F

021 U

MEDIUM BLUE 
#3255A4 

286 U

FLUORO PINK 
#FF48B0 

806 U

RED 
#FF665E 

286 U

Riso inks are soy-based and 
slightly translucent, meaning 
you can overlap just a few 
colours to create a wide 
range of new colours!

Riso inks are like newsprint- 
they never fully 100% dry 
(but they get pretty close!)

The inks are unique to riso 
printing. The colours produced  
cannot be fully replicated 
digitally. The hex codes 
provided here are digital 
approximations. To see exactly 

what the inks look 
like, please purchase 

a printed swatch 
pack online before 

ordering prints.



OVERLAYOVERLAY

We stock 8 inks that can either be used as 
spot inks, or overprinted to create new hues. 
You can choose to overlay colours, or knock out 
anything behind them to print directly on the 
paper.

Riso inks are slightly translucent, which makes 
them great for overlaying on top of each other. 
Many more colours can be achieved this way.

You can also 
print onto 

coloured 
paper! Ink 

colours will 
change 

depending on 
what paper 

they’re 
printed on!

Switch your layers to “Multiply” in the blend 
effects options when designing in Adobe 
to see an approximate of how it will print.

Adding trapping helps minimize any 
white gaps from the print misregistering.

Making sure the edges overlap will 
ensure a full colour fill/no white gaps.

TRAPPINGNO TRAPPING

+ =



PAPERSPAPERS

80gsm-120gsm is suitable 
for leaflets, flyers and zines. 

120gsm-250gsm is suitable 
for book covers and posters.

Riso works best on rough uncoated papers between 
80gsm-280gsm.

It is possible to print on 60gsm-300gsm depending 
on the paper, which would need testing. This is due 
to the paper at these more extreme grammages 
jamming in the printer or sticking to the stencil. It is 
preferrable to use them for shorter runs.

All paper that we print on is FSC certified 
and we either source it ourselves or from 
Arrowswift, a local paper supplier.

Please get in touch if you’d like a 
specific paper/colour or to make 
an appointment at the studio to 
see our paper samples in person.

We cannot risograph print on black 
or dark papers.

The more notice ahead of time you 
give us for a print project, the more 
we can ensure that your paper choice 
is in stock.

OUR PAPERS:
FABRIANO COLORE 80GSM - IVORY

ARALDA 100GSM - IVORY

FEDRIGONI ROUGH ARENA 120GSM - NATURAL

PRISMA 120GSM - WHITE

 CLAR 120GSM - LIGHT BLUE

DIGITAL PRA 135GSM -  WHITE

PRISMA 220GSM -  COLOURED LINE

MIXED MEDIA PAPER 180GSM- NATURAL

FABRIANO 160GSM -  COLOURED LINE

PRISMA 220GSM  -  IVORY

BRISTOL  4C 250GSM   - CREAM

GR TEXTURED BOARD 250GSM - BRIGHT WHITE

GR TEXTURED BOARD 250GSM - BRIGHT WHITE

KRAFT 280GSM  - BROWN

DIGITAL BF(DT) 300GSM  - NATURAL

PRISMA 300GSM- WHITE



PREPARING FILES + GLITCHESPREPARING FILES + GLITCHES

glitch

300dpi.

Set to greyscale/B&W.

Flattened PDFs (no layers or 
transparencies). 

Each colour layer saved as 
a separate file.

Max printable area is 410x287mm. 
The riso cannot print full bleed A3 
artwork, so please leave a 10mm border. 
Document size needs to be 420x297mm. 

Your image must be laid out on an A3  
sheet.

Label your files clearly, 
eg. artworkname_inkcolour.pdf

FOR PRINT, 
FILES NEED TO BE: glitch

Original digital file

Artwork by Antonia Gatt.

Riso print 
with glitches

If your file contains blend layers or effects such as 
drop shadows, the riso will wrongly interpret these 
effects and print visible boxes on your artwork. 
These elements need to be rasterised and flattened 
before print.



FLATTENING YOUR FILESFLATTENING YOUR FILES

Depending on your digital workflow, your PDFS 
might contain transparencies/blend layers/ 
effects that won’t show in the exported pdf, 
but will show in the riso prints. The riso print 
won’t match the on-screen art, resulting in 
unwanted artefacts and visible corruptions. 

This is why it’s important to rasterise and 
flatten images before exporting as PDFs.

Flattening layers discards any “invisible” layer 
content that isn’t visible on-screen.

Always make sure to save a copy of your work, 
as merging and flattening can’t be undone!

YOU SHOULD ONLY MERGE, 
FLATTEN  AND RASTERIZE YOUR

 FILES USING  ADOBE SOFTWARE!

SADLY, THE RISO PRINTER 
ISN’T COMPATIBLE WITH OTHER 

SOFTWARE FOR  THIS!

IMPORTANT!



FLATTENING YOUR FILES - CONT.FLATTENING YOUR FILES - CONT.
USING ILLUSTRATOR:

Select only the elements that are 
effected, to be rasterised and flattened,

In the “Object” menu, select “Flatten 
Transparency.”

In the pop up menu, set the custom 
preset to match the below:

In the “Object” menu, select 
“Rasterize” and set it to greyscale 
and 300dpi.

Hide/de-select elements that can 
remain as vectors.

USING  ADOBE  ACROBAT 
7, 8 OR LATER:

Select the “Clean Up” tab. If you get a 
prompt to save, select “Yes.”

If prompted, select “Discard User 
Data,” “Discard Hidden Layer 
Content, + Flatten Visible Layers,” 
and select “OK.”

When prompted, save the PDF as a 
new version/name.

Go to “View” > “Navigation Panels” 
>”Layers.”

Select the “Options” menu and select 
“Merge Layers” or “Flatten Layers.”

Save the PDF file.

Open your file, and select “Advanced 
> PDF Optimizer.”



FLATTENING YOUR FILES - CONT.FLATTENING YOUR FILES - CONT.
USING  PROCREATE:
Many use Procreate for their artwork and 
we are happy to help get your Procreate 
files print ready.

Simply export your Procreate file as a .PSD 
file for us.

Important: Please be sure to consolidate 
and organize your layers so that you have 
one individual layer for each ink color you 
plan to print with.

Generally we do not charge a file set up 
fee for well organized files.

Files with disorganized layers, multiple 
colors on one layer, or flattened artwork 
will require an additional file set up fee. We 
are happy to take a look and provide an 
estimate for the time it will take us to get 
your file ready for print.

USING PHOTOSHOP:

Go to “Image”> “Mode” and set it to 
“Greyscale.”

Export and save each layer as a PDF.

Go to the “Layer” menu and select  
“Flatten Image.”

PURCINELLA
PRESS

PURCINELLA
PRESS



“CLEANING” YOUR FILES.“CLEANING” YOUR FILES.

If your artwork has been scanned or used 
textures, the riso printer may interpret these 
differently from what you see on screen, and 
print them more visibly. Zooming in might help 
you spot some of these problems before you 
send them to print. Playing with the contrast 
or using the eraser tool can help remove these 
issues.

Spotting and fixing these issues in advance is 
your responsibility, as we won’t know if those 
textures are there intentionally or not.

During our free file check before printing, we 
will flag if we come across any issues that we 
spot, however somethings are impossible for 
us to know whether they’re deliberate or a 
mistake.

We are not responsible for the artwork 
that you send, but we will check them to 
the best of our ability.

WE OFFER FILE PREP SERVICES 
STARTING  AT 20 EUROS/HOUR.

A SINGLE  ART PRINT ON  
AVERAGESHOULD NOT  TAKE 

LONGER THAN  AN HOUR.

ZINES  ARE  A DIFFERENT MATTER.

IMPORTANT!

PURCINELLA
PRESS

PURCINELLA
PRESS



RISO IMPERFECTIONS.RISO IMPERFECTIONS.
Risograph printing is known and love for its 
imperfections. Do not expect perfect prints when 
risograph printing. These imperfections are totally 
part of the charm and look of risograph printing, 
and a big part of why they feel “handmade.”

Risograph printing isn’t perfect like a digital printer. 
The imperfections are intrinsic to this machine and 
its output.

ROLLER MARKS
Paper feeder rollers may leave marks 
on the page when a paper is run 
through the Riso multiple times and 
has heavy ink. This can be avoided 
by printing heavy inks last, and let 
them dry overnight. Print marks may 
also appear, but these can be easily 
rubbed off with an eraser if they are 
in a white area. 

INK TRANSFER
Heavy ink can lead to transfer 
between prints as the prints are 
stacked on top of each other as they 
exit the printer. Riso ink is also very 
similar to newspaper ink, meaning it 
never fully dries and can smudge if 
handled a lot. This can be avoided by 
not using large areas of solid colours 
and using our blotting services.

Although some of these issues can be minimized, it 
is always best to expect them going in!



RISO IMPERFECTIONS - CONT.RISO IMPERFECTIONS - CONT.
MISREGISTRATION
With Riso each ink colour is layered 
on separately, meaning registration 
will never be 100% accurate. That 
means a single sheet of paper will 
run through the machine multiple 
times for projects printing more 
than 2 layers, and the registration 
of colour can be irregular. In your 
artwork, allow 2-3mm for shifting or 
use trapping to help.

SMUDGING
Riso ink is made of soy oil, water 
and pigment, so like newspaper 
ink, smudging is a high possibility.  
Also, as Riso ink can smudge or 
rub off, it is preferable to avoid 
large block areas of color. There 
are ways on how to make a 
project more smudge resistant.  

The cleanest prints are those which 
are one-colour, have light coverage 
and printed on thick paper.



INK COVERAGE.INK COVERAGE.

It is recommended to avoid heavy areas 
of ink coverage, as it will cause the ink to 
flood and the paper to stick to the drum. 
This can cause a paper jam that would 
damage the paper.

Heavy in can also cause ink tranfser, 
smudging, needle marks (which looks like 
a scratch down the middle of the print) 
and uneven coverage.

Large areas of ink set between 90-100% 
opacity can result in a visibly uneven 
application of ink due to the ink flooding 
across the stencil. It can also cause 
problems around the edges, and top and 
bototm of the stencil. It’s best to keep at 
least 5cm clear at one end.

It is recommended that large areas of ink 
are no more than 75%. The riso can’t print 
100% ink across the entire paper.

Artwork by  
Pocket Sandwich Studio.

Artwork by Fleur Sciortino.

ink 
floodingneedle 

marks



INK COVERAGE - CONT.INK COVERAGE - CONT.
Heavy borders around the edge could also cause issues, and most likely won’t work and will most 
likely cause the paper to stick to the drum. It’s best to leave a gap at both ends the border, or set 
it to 75%.

Diagram by 
Risotto Studio.

Full border, 100% ink Full border, 75% ink Partial border, 100% ink



Print using 50% coverage across the 
entire page.

Avoid large areas of ink, especailly at 
the paper feed area (top of the print.)

Limit the number of colours (aka passes 
made through the printer.)

Reduce large areas of solid ink to a 70-
85% tint.

Print on thicker paper.

Ask to have your prints blotted. Prints 
stack on top of each other as they exit 
the printer. If there’s a lot of ink, they can 
smudge the back of the print on top. This 
can be especially problematic with 2-sided 
prints. You can request that we intersperse 
the prints with blotting paper at an 
additional cost.

TO ENSURE  A  
CLEANER PRINT:

ALTERNATIVELY, YOU CAN  ALTERNATIVELY, YOU CAN  
ALSO PRINT YOUR IMAGE ALSO PRINT YOUR IMAGE 

IN ONE COLOUR ONTO IN ONE COLOUR ONTO 
COLOURED PAPER!COLOURED PAPER!

INK COVERAGE - CONT.INK COVERAGE - CONT.



GRADIENTS.GRADIENTS.
Gradients in Riso can be quite tricky. 
The printer doesn’t interpret the 0-20% 
transition well, and will often just cut 
off.

For art prints, it’s often best if the 
lightest part of your gradient is set to 
20%.

For photos, it’s often best if the lightest 
part of your gradient is set to 10%.

Avoid setting the darkest part of the 
gradient beyond 90%, as it will cause 
ink flooding. gradient 

drop off

10%

0%

100%

90%

80%

70%

60%

50%

40%

30%

20%

Add 3 to 5% noise to raster 
gradient to create an even 
gradient instead of ‘stripes’.

Credits for these solutions 
goes to Riso Pop.

Flatten the gradients.

Save your files a TIFF > and 
especially if you will then use 
InDesign to export into a PDF!

When exporting to PDF, select 
the option PDF/X1a:2001 instead 
of High Quality.

Extra: In the riso driver, you can 
turn off the “backlight correction”  
option. You can find this under 
the tab Image > next to the Grain 
Touch/Screen Covered options > 
as an advanced button.

TO ENSURE  A  
BETTER GRADIENT:



TEXT AND TYPE.TEXT AND TYPE.

For text below 14pt, we recommend 
that you use registration black and in 
vector form, even if you’re not printing 
in black ink. This helps the RISO print 
text more sharply. Text can be set at 
a tint however that requires it to to 
be rasterized which can cause it to 
be less crisp.

Do not set type below 8pt. 
Be careful not to use too much ink 
density, as it can fill in the empty, 
knocked-out text. 
Too little ink can result in  
choppy edges. 
We recommend no less than 60% 
ink coverage for knock out text, and 
ideally not more than 80%.

We recommend that you use Indesign 
or Illustrator to create text. We don’t 
recommend that you create type in 
Photoshop, as it rasterizes it and 
causes the edges to become rough, 
instead of clean.

Avoid overprinting 
colours for body text. Any 

misalignment will make the 
text very difficult to read. 

Minimum recommended 
text size is 8pt 

(registration black only).

Minimum line size is 0.25pt 
(registration black only).

Keep text and lines as vectors. 
Do not rasterize!

OR

registration 
black

FOR KNOCK-OUT  TEXT:

100% ink coverage.

80% ink coverage.

60% ink coverage.

0.25pt 0.50pt 1pt

8pt 10pt 12pt 14pt 16pt etc.

KNOCK-OUT  TEXT

KNOCK-OUT  TEXT

KNOCK-OUT  TEXT



OPACITIES.OPACITIES.
The riso printer receives the images in greyscale. 
It interprets the ink density via the opacity in 
the black and white images. It will register these 
different shades of grey, which will be visible in the 
output. 

Each colour is printed separately using its 
own master stencil. The darker your original 
artwork, the stronger the ink will print.

One common mistake is to design in colour 
then hit ‘greyscale’ - that makes everything 
come out much paler.

Simply converting your work to “greyscale” 
in Photoshop (for example), isn’t enough to 
accurately prepare your work for print. 

For the best results, it’s best to work in black 
and white from the very beginning. Later on 
in this document, there will be more methods 
on workflow directly for riso-printing.

You should also double check that your 
background is completely white - any paper 
texture will be caught by the riso. It’s always 
best to adjust the contrast/levels before 
sending to print. If in doubt, up the contrast! 



GRAIN-TOUCH VS SCREEN-COVERED.GRAIN-TOUCH VS SCREEN-COVERED.
Riso automatically processes greyscale files into a 
bitmap, turning grey tones into dots using either the 
default grainy texture (Grain-Touch) or a halftone 
pattern (Screen-covered).

If you want to use a particular setting please 
specify when sending in your files.

There is no need for you to add any half-tone/
bitmap textures to your images. The printer does 
it automatically, but you need to let us know if 
you’d like us to print with half-tones.

The Riso will not print vector objects lighter than 
pure black in graintouch, only screen-covered. 
If you’d like vector objects to be printed with 
graintouch they must be rasterized at 600 ppi.

This controls the size of the dots produced.

Higher numbers: smaller, and more dots.

Suggested screen frequency 
numbers: 75, 80, 85.

It’s not recommended to go higher than 90.

SCREEN FREQUENCY:

Control the angle that the pattern is set to in 
order to avoid the moiré effect. For one-colour 
work, a typical angle is 45°. For two-colour 
work, You will put 30° angles apart from each 
other 15°, 45° (Usually the lighter colours get 
the lower angles). 

For faux CMYK printing:
Yellow:0° Pink:75° Blue:15° Black:45°

SCREEN  ANGLE:

These settings are found 
in the print driver.



A3 LAYOUT.A3 LAYOUT.
The Riso prints on maximum A3 paper, but it 
cannot print full bleed artwork. The maximum 
printable area is 287mm x 410mm.

Regardless of the final size of your work (be it 
A3, A4, A5, etc) it will be printed on an A3 sheet 
and cut down to size.

297mm x 420mm.
DOCUMENT SIZE:

A3 PAPER

UNPRINTABLE 
AREA

PRINTABLE 
AREA

287mm x 410mm.
MAX PRINTABLE  AREA:

Diagram by 
Risotto Studio.

If you intend your final print to be full-bleed, 
please make sure to add 4mm bleed to all sides 
of it. The bleed still has to be within the printable 
area of the page.

BLEED:

What is Bleed?
In printing, bleed is the area of a design that 
extends beyond the final trim edge, allowing 
images or colors to run to the very edge of 
the paper without white borders. Printers 
request bleed to make sure the final trim is 
neat, and not accidentally showing any white.  
 
Make sure there’s no important info/design bits in 
the bleed area, as it will be trimmed off!



CROP MARKSCROP MARKS
WHAT  ARE CROP MARKS?
Crop marks are the short lines in each corner 
of an exported PDF that tell the printer exactly 
where to cut. They sit just outside the trim edge, 
with a small gap (the offset) so they don’t print 
inside the bleed area.

Your crop marks should never touch, and they 
should not extend into the bleed area!

Crop marks are necessary to include if 
your final work needs to be trimmed down. 
 
If you’re printing an A3 poster with no bleed, 
there’s no need to include crop marks.

FINAL  ARTWORK 
(Within the printable 
area)

BLEED (Within the 
printable area)

PAPER (that will be 
trimmed)

CROPMARKS

CORRECT  CROP MARK SET UP
The marks are outside the 

bleed area and not touching.

INCORRECT CROP MARK SET UP
The marks are inside the 
bleed area and touching.



LAYOUT OPTIONSLAYOUT OPTIONS

STANDARD  A3
(with white border)

STANDARD  A4

STANDARD  A4

(with white border)

(with white border)

STANDARD   
A5

STANDARD   
A5

STANDARD   
A5

STANDARD   
A5

(with  
white border)

(with  
white border)

(with  
white border)

(with  
white border)

A4 FULL BLEED

A4 FULL BLEED

(reduced final size)

(reduced final size)

A3 FULL BLEED
(reduced final size)

A5 FULL 
BLEED

(reduced 
final size)

A5 FULL 
BLEED

(reduced 
final size)

A5 FULL 
BLEED

(reduced 
final size)

STANDARD   
A5

(with full bleed)

STANDARD   
A5

(with full bleed)

A5 FULL 
BLEED

(reduced 
final size)

Please refer to the 
templates on our 
website for how to 
set up your final 
layout to print!

Standard sizes 
without bleed 
don’t need crop  
marks!



NAMING YOUR FILESNAMING YOUR FILES
Since you have to send us your final files in black 
and white, it’s definitely not obvious to us which 
inks you might want to print in.

It’s super duper important that you name each 
file the colour you want it printed in. If you have a preference, please indicate  

which colours you’d like printed first (01, 02, 
03). We usually print lightest to darkest, to 
reduce track marks and smudging.

A 3 colour print would have 4 separate files.
EXAMPLE:

WE WOULD NEED:
One file for every colour you intend to 
print in.

A full colour proof for us to use as 
reference.

HOUSE_Proof.pdfHOUSE_Blue_03.pdfHOUSE_Red_02.pdfHOUSE_Yellow_01.pdf



HOUSE_Side01_Proof.pdf
HOUSE_Side02_Proof.pdf

HOUSE_Side01_Blue_03.pdf

HOUSE_Side02_Blue_03.pdf

HOUSE_Side01_Red_02.pdf

HOUSE_Side02_Red_02.pdf

HOUSE_Side01_Yellow_01.pdf

HOUSE_Side02_Yellow_01.pdf

NAMING YOUR FILESNAMING YOUR FILES

PLEASE DO MAKE SURE TO SEND  
US  A FULL COLOUR PROOF FILE!

THIS WILL HELP US SPOT  ANY  
POTENTIAL SET UP MISTAKES 

DURING OUR PRE-FLIGHT CHECK!

IMPORTANT!

IF SENDING MULTIPLE  
ARTWORKS, PLEASE ENSURE THEY 

HAVE DISTINCT NAMES!

PURCINELLA
PRESS

PURCINELLA
PRESS

FOR DOUBLE SIDED  ARTWORK, PLEASE  
MAKE SURE TO INCLUDE THE SIDES:



HOW TO PREPARE YOUR FILES TO PRINTHOW TO PREPARE YOUR FILES TO PRINT
There are several different ways you can prepare 
your files to risograph print.

WHILE YOU CAN  ADAPT MOST WORKS  TO RISOGRAPH PRINT,   
THE BEST  RESULTS   ARE  ALWAYS  THOSE WHICH WERE PREPARED  

WITH RISO PRINTING IN MIND FROM THE BEGINNING.

ALL OF THE ABOVE TECHNIQUES  ARE ONLY SIMUALTIONS  AND  
WILL NEVER BE 100%  ACCURATE TO THE FINISHED PRINT.

Screen Lock Technique
With this technique, you plan your 
image right from the beginning in 
greyscale, using blend layers to 
simulate the colours.

Alpha Lock Technique
With this technique, you need to 
know which colours you intend to 
print with right from the beginning.

Channel Separation Method
With this technique, you need to know 
which colours you intend to print with 
right from the beginning.

Spectrolite
With this technique, you need to 
know which colours you intend to 
print with right from the beginning.



SCREEN LOCK TECHNIQUESCREEN LOCK TECHNIQUE

Set up as many layers as you want 
colours. For the sake of this example, we’ll 
be working with only 2 colours, RED and 
BLUE.

Create one layer and label it RED. Set it 
to Multiply mode. Create a second layer 
and label it BLUE. Set it to Multiply also.

Next, create a new layer, and make it a 
clipping mask and clip it to the RED layer. 
Using the bucket tool, fill this clipping 
mask with the colour red. Set this layer 
to Screen mode.

Repeat this step for the Blue layer, but 
fill the clipping mask with the colour blue.

This set up will emulate the riso printing 
colour overlays. This method also easily 
lets you change colours and experiment 
with different combos.

This is the technique we tend to favour when designing artwork. 

Clipping mask set to Screen, 
filled with colour.

Clipping mask set to Screen, 
filled with colour.

Normal layer, in B&W, set to 
Multiply. Labeled “BLUE.”

Normal layer, in B&W, set to 
Multiply. Labeled “RED.”

Change layer mode from here.



SCREEN LOCK TECHNIQUESCREEN LOCK TECHNIQUE

Once you’re done designing your artwork, 
save up a new version. Delete all the 
clipping masks and set all the B&W layers 
to Normal layer mode. Each B&W layer 
should still be labeled the desired final 
colour.

Export each layer individually as a B&W 
pdf. Make sure they’re 300dpi and the 
right size.

TIP: With this technique, we prefer to 
play around with opacities with different 
layers, rather than through the brush 
opacity. It gives more control over the final 
result or if you want to change anything 
later on.

Please save out the artwork into one of 
the attached templates on our website 
should you require any trimming or sizes 
other than A3. 



ALPHA LOCK TECHNIQUEALPHA LOCK TECHNIQUE

Draw/paint within layers directly using 
the colours you want to print in. Make 
sure that you separate layers based on 
colour.

For example, only paint with red on 
one layer.  Anything in blue, paint on a 
separate layer. All layers should be set 
to Multiply mode. Make sure to work in 
separate layers.

With this technique, make sure to change 
opacities through the brush settings, not 
the layer settings.

When you’re done drawing/painting 
make sure to save a new version! As we 
continue we will be making changes that 
can’t be undone.

Once you’re saved, select a layer and 
enable the Alpha Lock.

For this technique, you need to know what colours you want to print with from the very beginning.

Multiply layer, in colour. Labeled 
“BLUE.”

Multiply layer, in colour. Labeled 
“RED.”

Enable Alpha Lock  
from here.



ALPHA LOCK TECHNIQUEALPHA LOCK TECHNIQUE
Select the colour 100% black and paint 
the layer. You should be able to see the
opacities you’ve made show up as greys.

You can repeat these steps to visualise 
how your layers look when printed. The 
multiply mode will emulate the mixing of 
the colours as they would after printing.

This is a more organic technique for those who like painting, 
but is much harder to experiment with or make changes 
after.

Once you’re done converting everything 
to B&W, merge the layers based on final 
print colour. AKA all red layers (which 
are now B&W) get merged together into 
one Normal layer. All the blue layers get 
merged and so on.

Export each layer individually as a B&W 
pdf. Make sure they’re 300dpi and the 
right size.

Please save out the artwork into one of 
the attached templates on our website 
should you require any trimming or sizes 
other than A3. 

Both layers have Alpha lock enabled, 
and have been filled in with 100% Black.

Both layers have Alpha lock enabled, 
and have been filled in with 100% Black.



CHANNEL SEPARATION METHODCHANNEL SEPARATION METHOD
This software is great for converting photos and traditional scanned art into risograph ready art.  
Channel separation via custom color profiles give the most accurate results, but they can cost money, 
have a non-negligible learning curve, and requires profiles for each combination of inks.

Here are two useful videos that explain this method:

CMYK Separations Risograph Tutorial by Olivia and Pindot

HOW TO: Use Color Profiles for Riso Printing by Risolve



SPECTROLITESPECTROLITE

Spectrolite is a free software that can be downloaded here: https://spectrolite.app/

This software is great for converting photos and traditional scanned art into risograph ready art 
without the cost and difficulty of colour profiles.

Spectrolite is a great software. Spectrolite does 
not use CMYK channels at all. It analyzes each 
pixel of the artwork you supply and calculates 
how much of each color in your ink palette is 
needed to create the closest equivalent color. In 
other words, it creates channels for each ink that 
have no relation to CMYK or RGB separations. 
Spectrolite uses the hexcode equivalent value 
for each riso ink, and does not appear to take 
ink opacity into account, so the results are still 
not as accurate as custom color profiles would 
be.

In general, big bold overlapping geometric shapes 
will highlight the limitations of Spectrolite. The 
edges of shapes may show odd artifacts, and 
you might find ghost impressions of colors where 
you wouldn’t expect them.

If you are able to create your art in a way with 
colors already separated by desired ink, use those 
layers to create separations: don’t flatten that art, 
then bring that into Spectrolite. 



FAUX CMYK EFFECTFAUX CMYK EFFECT

GENERAL PREP TIPSGENERAL PREP TIPS

When attempting to riso print photos or images with a 
wider colour spectrum, a faux CMYK effect can be used 
to imitate the real CMYK printing process. This is done by 
using the riso inks yellow, black, fluorescent pink and blue 
(as opposed to magenta and cyan). Other inks can also 
be used to create the desired pallet, depending on your 
intended final result.

When printing images, m,ake sure there is good contrast 
overall and open up the mid-tones.

Please don’t apply any halftone effects to the artwork. The 
riso printer will do this automaticall through the screen-
covered option. Just make sure to let us know that you’d 
like us to print with that option. 

In addition, the riso printer also automatically adds noise/
texture to the final print, so be careful what textures you 
add to your image.

Flatten any layers with an  
adobe software before  

exporting your PDF

Files should be 300dpi resolution

Create a separate grayscale  
PDF for each ink colour/layer

Label your files clearly

Your overall file should  
be A3 size (420 x 297mm)

Leave a minimum of 10mm blank 
margins on each edge (maximum 
printable area of 410 x 287mm)

ALWAYS DOUBLE CHECK:



EXTRA SERVICESEXTRA SERVICES

Rush Job

If you need to fast track your print job, we’ll try 
accomodate you. 

This extra fee is calculated at a percentage of the 
project depending on the overall complexity.

Print Proofing

Due to the Riso process, print proofs aren’t 
standard practice as most of the cost is in the 
initial printing set up and stencil making. We do 
however offer this service at €15 per colour stencil 
tested.

Please keep in mind that this will add on production 
time to the overall job, to give you time to see the 
proof by appointment.

We recommend this service for very large print 
runs or colour sensitive orders.

Blotting

If you require reduced smudging and a cleaner 
finish, we highly recommend this service, especially 
for business cards, invitations and greeting cards.

The fee for this service depends on the overall 
quantity of prints ordered.

Each riso print is separated with blotting paper 
as they pass through the machine. This process 
helps soak up any extra ink and protects the back 
sides from unwanted transfer.

File Prep Services

If you are struggling to prep your files to print, 
this is a service we provide starting at €20 per 
hour.



EXTRA SERVICESEXTRA SERVICES

WorkshopsDesign Services

Please do reach out to us should you wish us to 
design your print project from scratch Tell us about 
your project and we’ll pair you with a designer 
who will bring your project to life, either from our 
in-house designers or by connecting you with a 
trusted artist. 

The price depends on the artist.

Consultation

Ok, so you’ve been patient enough to read through 
all this info but you’re still missing something, or 
maybe it’s too much and you’d like to speak with a 
human? We are happy to help and advise on your 
project any time, if you prefer in-person meet-ups, 
we could arrange a studio visit or an online call.

We offer a 60 minute consultation for an additional 
fee of €30. 

Want to have a hands on, in-depth workshop 
about how to prepare your work and actually 
print with the machine? Reach out to us for a 
private workshop.

We can accomodate up to 4 people, and the 
workshop is typically 6-7 hours.

Our pricing for this kind of workshop starts at 
€20 per hour, so a 6-7 hour workshop would 
cost €120-€140 without VAT. This price includes 
printing materials.



TURNAROUND TIMETURNAROUND TIME

We can shorten the drying time 
via our Blotting Service, where 
extra paper is layered between 
each print to soak up excess ink.

Although the overall Riso printing time is 
fast, certain aspects of a job still take time, 
especially as we do our due diligence to ensure 
high quality prints.

The pre-flight checks, drying and trimming time 
and making your prints as aligned as possible 
are all a part of this process.

The more layers/colours you use, the longer 
it takes. We like to leave at least 24 hours 
between each layer to reduce the potential 
for smudging.

Also, if you’re ordering specific paper and we 
don’t have it in stock, we need to source it 
and trim it down to A3 from our local supplier. 
This will add roughly 5-10 working days on 
average.

Please ask about turnaround times. They 
change depending on the time of year and the 
project.

PURCINELLA
PRESS

PURCINELLA
PRESS



Any transparencies or layer effects such as  
drop shadows, masks and so on, or if your files are 
made up of varying elements (smart objects etc),  

please make sure to set all blend modes to normal, 
remove or fully incorporate these effects  

and flatten your artwork down.

If using any gradients, please make sure to check  
the gradients page to ensure your lightest  
values don’t fall within the 10-20% range.

If using any small text, thin lines/logos, please 
 have them set to “registration black” and  

do not rasterize them.

Please make sure to thoroughly check any  
illustrations or text, scanned or otherwise, that have 
been edited in Photoshop, to ensure they have been  
“cleaned up” fully and have no unwanted artefacts.

THESE  TEND TO BE:

AMENDMENTSAMENDMENTS COMMON PROBLEMSCOMMON PROBLEMS

Once printing has started, it is not 
possible to make amendments. 
The print job will have to be 
done from scratch and charged 
accordingly.

If we are not the ones preparing 
your files to print ourselves, any 
issues are your respnsibility 
to check and correct, and we 
cannot be held liable for this 
artwork set up.

Although we do a pre-flight check 
before printing, it is impossible 
for us to spot certain issues with 
your file until we’ve printed it.



TERMS & CONDITIONSTERMS & CONDITIONS
All print jobs are to be paid for in full before it 
leaves the studio.

All orders are subject to acceptance and 
availability.

We reserce the rights to modify, alter, terminate 
or discontinue any discounts or promotions at any 
time for any reason whatsoever withotu notice.

You are responsible for ensuring the the artwork 
you send to print is correct, accurate, and 
appropriate for publication and printing. Do not 
submit anything you know to be unlawful or harms 
the rights of others.

A confirmed job request will be taken as order 
confirmation.

When you confirm an order, it means that you have 
read and accepted our Terms and Conditions.

If a job is later cancelled by you, you will be charged 
for any costs incurred (such as paper ordered in).

Work over €150 will require a 50% deposit before 
printing can commence.

You acknowledge that all details which you provide 
to us for the purpose of the job are correct, that 
the credit/debit card you are paying with is your 
own and that you have sufficient funds to cover 
the cost of the order.

You acknowledge that the turnaround time is 
variable and might change depending on the job.

We accept no responsibility for any missed 
deadlines should the files be incorrectly submitted 
or require amendments.

We reserve the right to revise the price of items 
without notice.

We will do a pre-flight check before printing, 
but we do not monitor the content, If you have 
prepped the file, it is up to you that the file is set 
up correctly.



We have made every effort to accurately display 
our products with the correct information and 
colour. However, we cannot guarantee that all 
monitors display accurate colours of the products 
as each monitor displays differently.

We are unable to accept responsibility for work 
that is not collected within 6 weeks of completion.

If a full colour proof is not provided, then we will 
not print the work until it is received.

In the event of delay or loss in the post or by 
a courier, we will not be held liable under any 
circumstances for consequential loss or damages 
resulting from third party actions.

TERMS & CONDITIONS  TERMS & CONDITIONS  
- CONT.- CONT.

DISCLAIMERDISCLAIMER

The Risograph printer is not perfect like a 
digital printer and imperfections are part 
of the process. The prints will look different 
from what you see on your monitor.

There will be print marks, especially when 
printing more than one layer or double sided. 
Registration will not be perfect, with each 
print varying slightly from one to the next.

Part of the appeal of this process are these 
imperfections coupled with the hand printed 
quality, as this is the intrinsic nature of the 
machine and its output.

Unlike most other printing methods, 
Risograph spot colour inks do not conform to 
a pantone standard (the provided Pantones 
are approximates. Additionally, the inks are 
slightly translucent so finished colour will vary 
dependiong on your paper choice. The ink is 
also simiilar to newspaper ink and never fully 
dries.

We cannot guarantee that supplies (such as 
paper) quoted in initial email correspondence will 
be available immediately.



OTHER RESOURCESOTHER RESOURCES
Stencil Wiki
Stencil.wiki is a comprehensive 
resource dedicated to stencil 
printing, providing tools, guides, and 
a collaborative platform for artists, 
designers, and enthusiasts to explore 
techniques and innovations in stencil-
based printing.

RISOTTO Website
A Riso studio based in Glasgow, 
their website is a treasure trove 
of information. They even have a 
browser riso simulator!

Spectrolite
Created by Anemone Press, this free 
software is invaluable to prepare 
your files to riso print.

Layout Department
Created by Anemone Press, Layout 
Department is software for laying 
out books, zines, and booklets. You 
drag and drop PDFs to make the 
imposed print files. It’s a tool for 
artist publishers, small printshops, 
and people who like making print 
publications. There’s a free and a 
paid version.

Exploriso
An incredible in-depth resource on all 
things Risograph printing, including 
its history.

Natalie Andrewson
A Riso printing giant, her book 
“Dreaming in Colour” and her Patreon 
are fantastic resources!



FUTURE PAGESFUTURE PAGES

In the future, this guide will have more info on:

Layout imposition for zines.

Page creep

Colour profiles

Binding methods

Duotone images

Scanned samples of our paper


